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Default User Setting: 
• Default View – Which SOSOS view is the default.  Choices are Report, Text, and Grid 
• Include Details – Determines if the Text view, saved Text Report, or printed Text Report 

includes a lot of details.  Use this setting to reduce the size of the report by not including 
details. 

• Default Font – The default font used throughout the program 
 
Note: These settings are the defaults for new users of the application.  They have no effect on 
existing users who may have already saved these settings. 









 
Switch Optional Arguments Notes 
/UsePingValidation None Use ICMP “ping” to verify that a PC exists 

before attempting to collect data 
/Domain Name of the domain or 

workgroup 
The domain/workgroup used to generate the 
list of PCs 

/OU_Filter The “distinguished 
name” of the OU 

Used to “filter” the list of PCs (Active 
Directory domains only) 

/NameFilter PC Name with 
wildcards 

Used to “filter” the list of PCs 

/PoolSize Number of concurrent 
PCs to process 

Increase this number to poll the network 
faster, increases the load on the local PC 

/PollLogDirectory Path to an existing 
directory 

If the polling log file name is generated 
automatically, this is the location where the 
file will be created 

/PollLogFile Path to the log file The full path to the log file (turns off 
automatic file name generation) 

/PollLogLevel Full, Errors, Summary, 
or None 

Control the level of detail that appears in the 
Polling log file 

/PollByAge Age (in days) that a 
database record is 
considered “old” 

Used to “freshen” existing records in the 
database by polling only those PCs whose 
records are older than the number of days 
specified 

/PollByFileFile Path to a text file that 
contains a list of PCs to 
be polled 

Used to poll a specific list of PCs 

/PollMethod AD, NT, Browse, File, 
or Age 

The method used to generate the list of PCs 

/PollTimeout Minutes to wait Used to make sure that the polling is not 
“stuck” on a PC for longer than the number of 
minutes specified. 

 
Note:  Items in the Configuration file are processed first, followed by the options that appear on 
the command line. 
 
When used to “freshen” the existing records in the database, the command line might include: 
 PollSOSOS /PollMethod Age /PollByAge 7 /PollLogFile “C:\Temp\SomeLog.txt” 
 
When used to poll an Active Directory domain, the command line might include: 
 PollSOSOS /PollMethod AD /Domain consoto.com /OU_Filter 
OU=Sales,DC=Consoto,DC=com 
 
Note: You should run PollSOSOS from a PC that’s running the latest operating system (i.e. 
Windows Vista).  See Appendix C for more information about the effects on the data collected. 
 
3.4 ViewSOSOS 



 
This is a read-only database viewer for the SOSOS data in the database.  It has no data gathering 
or scanning capabilities. 
 
ViewSOSOS accepts a single PC name as a command-line argument.  When used, it will retrieve 
the existing data for that PC and display the results. 
 
Note: Administrators may prefer to use direct access to the underlying database to view, query, 
edit, and manage the SOSOS information. 
 
3.5 ConfigureSOSOS 
 
Use this utility to perform setup configuration tasks for each of the SOSOS-related applications.  
This application does not support command-line arguments. 
 
Note: The configuration files for the “target application” are found in the same directory as the 
application’s EXE file.  Changes are not effective until the target application is restarted. 
 
You can use ConfigureSOSOS to configure applications after deployment or during 
development.  If used during development, you must select the app.config file in the source code 
directory.  When used after deployment, you select the application’s config file that resides in the 
same directory as the application itself (i.e. RunSOSOS.exe.config) 
 
Note:  The ConfigureSOSOS utility cannot be directly used to configure SOSOS_fx1.1 and 
RunSOSOS_fx1.1 (these programs are available as additional downloads and are not part of the 
distribution kit).   Instead, you must first use ConfigureSOSOS to configure the “normal” 
versions of SOSOS and RunSOSOS and then copy the encrypted connection string data to the 
*.config files for SOSOS_fx1.1 and RunSOSOS_fx1.1 by hand (i.e. using Notepad). 
 
Important: This utility is particularly important since the connection strings to the database 
may be encrypted and therefore editing the configuration files by hand is not possible. 
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Note:  The table below represents the minimum requirements; it is always advisable to install the 
latest components. 
 
OS Scenario SP Framework MDAC Installer IE WMI 
WinXP Local 2 2.0 2.8 3.0 5.01 Preinstalled 
WinXP Remote N/A No No No No Preinstalled 
Win2k Local 3 2.0 2.8 3.0  5.01 Preinstalled 
Win2k Remote N/A No No No No Preinstalled 
Win2k3 Local N/A 2.0 2.8 3.0 6.0 Preinstalled 
Win2k3 Remote N/A No No No No Preinstalled 
WinNT Local  Not supported     
WinNT Remote 4 No No No No 1.5 
Win98/Me Local N/A 2.0 2.8 2.1 5.01 1.5 
Win98/Me Remote N/A No No No No 1.5 
Win95 Local  Not supported     
Win95 Remote N/A No No No No 1.5 
 
Note:  SOSOS_fx1.1 and RunSOSOS_fx1.1 are available as additional downloads and uses the 
.Net Framework v1.1 to aid organizations that have not completed the migrated from version 1.1 
to version 2.0 of the .Net framework.  This also allows WinNT to run the application locally. 
 
The prerequisite software is available from the Microsoft web site: 
 
Component Download URL 
.Net Framework 2.0 http://msdn.microsoft.com/netframework/downloads/updates/default.aspx 

MDAC http://www.microsoft.com/downloads/details.aspx?familyid=78cac895-
efc2-4f8e-a9e0-3a1afbd5922e&displaylang=en 

Jet 4.0 http://www.microsoft.com/downloads/details.aspx?familyid=2deddec4-
350e-4cd0-a12a-d7f70a153156&displaylang=en 

Windows Installer http://www.microsoft.com/downloads/details.aspx?familyid=889482fc-
5f56-4a38-b838-de776fd4138c&displaylang=en 

Internet Explorer http://www.microsoft.com/downloads/details.aspx?FamilyID=1e1550cb-
5e5d-48f5-b02b-20b602228de6&displaylang=en 

WMI http://www.microsoft.com/downloads/details.aspx?FamilyID=afe41f46-
e213-4cbf-9c5b-fbf236e0e875&DisplayLang=en 

 
5.3 Additional Requirements for Remote PCs 
 
In order to successfully obtain SOSOS data from a remote PC, all of the following must be true: 
 

• You are an administrator on the Remote PC 
• Firewall settings must allow “Remote Administration” traffic to pass 
• Remote Registry services are installed (Not preinstalled on Win9x clients) 
• An “administrative” share (i.e., C$) is available (Not preconfigured on Win9x) 
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Administrator Account 
 
The account used on the local PC to gather information on a Remote PC must be in the 
administrators group on the Remote PC.  Typically, you’d use an account that’s in the Domain 
Administrators group to remotely gather SOSOS data. 
 
The User Account Control (UAC) feature of Windows Vista doesn't allow for a connections to a 
remote Windows Vista PC when the user in logged in via a local account.  This isn’t normally a 
problem, since members of the Domain Administrators group are “domain accounts” and not a 
“local accounts”.  However, in a Workgroup environment (where you only have local accounts), 
you must disable UAC on the Remote PC. 
 
From the Control Panel, click on User Accounts, and click on “Turn User Account Control on or 
off”.  Clear the checkbox and press the OK button.  (This change will require a reboot). 
 
Firewall Settings 
 
A common requirement is to configure the firewall settings for Windows XP SP2 clients to allow 
for “Remote Administration”.  You can use a Group Policy Object (GPO) or use the following 
command line on each PC: 
 

netsh firewall set service RemoteAdmin enable 
 
For additional information on configuring the WinXP Firewall to allow Remote Administration 
traffic, see:  http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/wmisdk/wmi/connecting_through_windows_firewall.asp. 
 
For Windows Vista, the technique used to allow remote connections via WMI is a bit different. 
From the Control Panel, click Security, click Windows Firewall, click Change Settings, and then 
click the Exceptions tab.  In the Exceptions window, put a check for the item Windows 
Management Instrumentation (WMI).   Alternately, you use the following command line: 
 
 netsh advfirewall firewall set rule group="windows management instrumentation (wmi)" 
new enable=yes 
 
For additional information, see: http://msdn2.microsoft.com/en-us/library/aa822854.aspx 
 
The Windows Vista firewall may also need to be configured to allow File and Print Sharing. 
 
Remote Registry Services 
 
By default, Windows Vista has the "Remote Registry" service set to Manual and it is stopped.  
So, in order to connect to a remote Windows Vista PC, you'll have to set the service “start type" 
to Automatic (and start the service).  
 

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/wmisdk/wmi/connecting_through_windows_firewall.asp
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One of the features of the .Net Framework allows users to set “code access permission” for the 
PC (or individual programs).  By default, the Framework's own security settings will not allow 
any program to run from a network share that requires "significant" permissions.  Since SOSOS 
requires a lot of permissions to work properly, the default settings will not allow it run from a 
network share. 
 
Note: The default Code Access Permission settings are sufficient when SOSOS is run from the 
local drive. 
 
To solve the problem, you can either copy the program files to a local drive, or adjust the .Net 
Framework assembly permissions on each PC. 
 
To adjust permissions, you use the .Net Framework 2.0 Configuration control panel applet (on a 
development PC).  Navigate to "Configure Code Access Security Policy", “Adjust Zone 
Security”, "Make changes to this computer".  Click on the Local Intranet icon and move the 
slider up to "Full Trust". 
 
You can also use the .Net Framework 2.0 Configuration control panel applet to create an MSI 
file that you can use to deploy these changes via a GPO or login batch to the other PCs in your 
LAN.   Click on the "Configure Code Access Security Policy", "Create Deployment Package".   
When the Wizard opens, click on the "Machine" security policy, and select a folder/name of the 
MSI file that will be created. 
 
Alternately, you can use the LocalIntranet.msi file included in the SOSOS Distribution Kit. 





After you’ve reached a comfort level with the deployment, then you should consider changing 
both the Error Logging Level and Poll Logging Level settings to “Errors”.  This will reduce the 
“chatter” in the log files while preserving those entries that are true errors. 
 
6.3 Embedded Database Errors 
 
Most minor errors are also recorded in the database.  The error messages are generally short and 
truncated to fit inside the particular table column.  Messages are preceded by the text “Error:”.  If 
a numeric field is available, it is set to a negative number. 
 
Note: Logging levels do not affect the appearance of embedded error messages in the database. 
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Appendix A – Deployment Checklist 
 
When deploying SOSOS, consider the following steps: 
 
Pre-deployment: 

• Read the Setup and Configuration Guide (this document) and the User’s Guide 
• Calculate the size of the database 
• Determine hardware/software requirements for the database 
• Get whatever approval is required to proceed 
• Purchase a suitable database program (if required) 

 
Deploy the database: 

• Install the database application (if required) 
• Create a database using one of the provided “prototypes” as a starter 
• Verify primary keys and foreign key constraints 
• Establish an authentication/authorization scheme for the database 
• Secure the database as appropriate for outsiders, ordinary users, and administrators 
• Consider using extra security settings on the EventLogs table 

 
In a lab environment: 

• Change the encryption keys (Vector and TheKey) in Crypt.vb 
• Compile the SOSOS application 
• Copy the SOSOS.exe and SOSOS.exe.config file to a test PC 
• Run SOSOS on the test PC to configure the “required settings” sections 
• Test SOSOS and the database connectivity 

 
Determine the deployment scenario 

• Choose a deployment scenario or a combination of scenarios 
• Determine the connect string settings for each SOSOS application 
• Run ConfigureSOSOS for each SOSOS application 

 
Deploying the clients (highly dependent on deployment scenario): 

• Install missing/outdated components on each client 
• Configure .Net Security on each client 
• Copy the application and application config files 
• Run ConfigureSOSOS on the app.config files and build the Setup projects 
• Edit login batch file 
• Create scheduled tasks 

 
Post deployment: 

• Check the text-based error log file 
• Review the data in the tables for embedded error messages 
• Verify the security of the database 



Appendix B – Database Table Descriptions 
 
Table Name Description 
Accounts A listing of all local accounts 
Admins Members of the local Administrators group 
AutoUpdate Automatic Update settings 
BIOS BIOS information 
Components Windows components (similar to installed software) 
CPU Processor information 
Desktop User’s desktop (screen saver, wallpaper, etc) 
Devices Listing of devices (similar to device manager) 
Disks Physical disk information 
Drives Logical drive information (drive letters) 
Email User’s Microsoft Outlook settings 
EventLogs Event Log entries 
EventLogSettings Setting for each Event Log 
FileInfo Information about an ad-hoc list of files 
Internet User’s Internet Explorer settings 
Mapped User’s mapped network drives and printers 
Memory Quantity and type of RAM 
Modem Modem information 
Monitor Video Monitor information 
Motherboard Motherboard information 
Mouse Mouse 
NetAdapter Network Interface Card (NIC) information 
NetConfig NIC Configuration 
OS Operating System details 
PC Miscellaneous PC information 
Permissions Permissions on network shares 
Ports Number and type of ports 
Printers Local and network printer information 
Processes List of running processes (similar to Task Manager) 
Profiles Listing of User Profiles (i.e. C:\Document and Settings) 
QFE Updates/Patches (QFE=Quick Fix Engineering) 
Registry Information about an ad-hoc list of registry keys 
Services List of Windows Services 
Shares Information about network shares 
Software Listing of installed software 
SOS Summary information (root of many tables) 
Startup User’s automatic startup applications 
SystemDrivers List of system drivers (useful in recovery console) 
SystemInfo System identification and serial numbers 
Tasks Listing of scheduled tasks 
UserLogin Record of every login 
Video Video card information 
Virus Norton Antivirus Corporate Edition logs 



Appendix C – Affects on Collected Data 
 
Administrator 
 
The following table describes the affect on the information that is collected if the current user is 
not a member of the local administrators group on the PC. 
 
Table Name Notes 
Desktop Only entries for the current user and the Default User 
Email Only entries for the current user and the Default User 
EventLogs No entries for the Security Log.  All other event logs are recorded 
Internet Only entries for the current user and the Default User 
Mapped Only entries for the current user and the Default User 
Permissions No entries 
Startup Only entries for the current user and the Default User 
Tasks No entries 
Video Only partial data will be collected 
 
User Mapped Drive Letters 
 
SOSOS does not follow files that have mapped drive letters to network shares (such as 
“H:\SomeFile.txt”).  This would most likely happen in the Email table where the user may store 
his/her PST file on a network share using a mapped drive letter.  In this case, the file name is 
recorded, but the file size will show 0. 
 
Remote Collection 
 
When collecting data from a remote PC running Windows Vista, the Task table will only be 
populated if the local PC (the one running the application) is also running Windows Vista. 
 
Development Platform 
 
The Task table will only be populated on a PC running Windows Vista if the SOSOS application 
was also compiled and configured on a development PC running Windows Vista.



Appendix D – Supported Environmental Variables 
 
The use of System Path environmental Variables allows SOSOS to more accurately find files on 
remote PCs.  This feature is particularly handy when creating the list if ad-hoc files for the 
FileInfo feature (See: Section 2.5) 
 
Note:  The 64-bit versions of Windows have both a “C:\Program Files” and “C:\Program Files 
(x86)” directory to allow side-by-side program installation. 
 
The following environmental variables are supported by the SOSOS suite: 
 

• %ProgramFiles% - typically C:\Program Files 
• %ProgramFilesx86% - typically C:\Program Files (x86) 
• %CommonProgramFiles% - typically C:\Program Files\Common Files 
• %CommonProgramFilesx86% - typically C:\Program Files (x86) \Common Files 
• %SystemRoot% – typically C:\Windows 
• %SystemDrive% – typically C: 
• %windir% - same as SystemRoot 

 
Note:  The normal file name wildcards (* and ?) can also be used in the ad-hoc files listed in the 
FileInfo feature.  Example: “%SystemRoot%\system32\Macromed\Flash\Flash*.ocx”. 



http://www.sosos.emmet-gray.com




4. Running SOSOS 
 
The most common task in SOSOS is to collect data from the local PC.  You perform this 
function by clicking on the Collect Data button (or from the File/Collect Data menu).  The 
SOSOS screen will look like the following: 
 

 
 
Click on the item in the left-hand list (i.e. CPU) to view the data for that item. 
 
SOSOS supports three different methods of viewing the collected data.   

• The Report View uses a database-style navigator to view individual records 
• The Grid View displays all records in a grid 
• The Text View is a text-based view suitable for printing and saving to a text file 

 
After the data has been collected (via the “Collect Data” button), the user has the opportunity to: 

• Save the results to the database 
• Write the results to a text file 
• Print the results 
• Display summary data as a “watermark” on the user’s desktop 
• Export the results to an XML file or a Microsoft Access database file 



4.1 File Menu 
 
The File Menu is used to perform the most common tasks: 
 

 
 
File Menu: 

• Collect Data – Collects SOSOS data from the local PC 
• Save to Database – Saves the collected data to the database 
• View Database Records 

o For this PC – View the existing database records for this PC 
o Enter a PC Name – Enter the name of a PC to view its database records 

• Save Text Report – Save the data to a file using the Text View format 
• Print Text Report – Print the data using the Text View format 
• Page Setup – Set up the page for printing 
• Exit – Exits the program 

 
4.2 Data Menu 
 
The Data Menu is used to import and export data 
 

 
 



Data Menu: 
• Import from XML – Imports data from a previously exported XML file 
• Export to XML – Export the data to an XML file.  Use this option if you plan to later 

import the data using the Import from XML option. 
• Export to XML w/schema – Export to an XML file and also include the “schema”.  Use 

this option if you plan to export the data into some other application. 
• Export to Microsoft Access - Export to a Microsoft Access (mdb file) 
• Save as Wallpaper – Create a summary “watermark” on the user’s desktop 

 
There may be situations where you want to record data from PCs that are not connected to any 
network.  To handle this, SOSOS can export its data into an XML file.  An Administrator can 
take this XML file to another PC (that is on the network) import the XML file and save the data 
to the database. 
 
4.3 Poll Menu 
 
The Poll Menu is used to collect SOSOS data from remote PCs on a LAN.  This operation 
requires the user to have administrator rights on the remote PCs.  Typically this function would 
be performed by a member of the Domain Administrators group. 
 
There are several choices as to the method used to generate the list of PCs that will be “polled”. 
 

 
 
Poll Menu: 

• By Active Directory Domain – Use Active Directory domain and Organization Unit 
(OU) to generate the list of PCs 

• By Network Browsing – Use the list of PCs that are visible in the My Network Places.  
Does not require a domain. 

• By File Contents – Use a text file that contains a list of PCs.  The PC names should be 
listed one per line 

• By ad-hoc List – Type the names (or cut and paste a list of PCs) that will be used 
• By IP address – Use a list of IP address ranges to poll the network 
• By NT Domain – Use Window NT-style domain lists 



• By Age of record – Run a query on the database to produce a list of PCs whose data is 
older than a certain number of days. 

 
After selection of a polling method, the menu will look similar the following (using the Network 
Browsing method as an example): 
 

 
 

Generate List by Network Browsing: 
• Workgroup or Domain – Filter the list of PCs to be generated to only those in the 

selected workgroup/domain 
• PC Name Filter – Filter the list of PCs by using a wildcard (i.e., SALE* will limit the 

list of PCs to those whose name begin with SALEs). 
 
Note:  The top portion of the form is dependent upon the polling method selected and may 
display different options from this example (using the Network Browsing method). 
 
Poll Option: 

• Use ping validation? – Should SOSOS use an ICMP “ping” to verify that the remote PC 
is actually on line before attempting to connect to the PC?  Can speed up the process, but 
some PC firewalls block ICMP traffic. 

• Poll Timeout – The number of minutes to wait before abandoning a “stuck” PC and 
moving on the next PC in the list 



• Concurrent PCs – The number of PCs to scan at the same time.  Increasing this number 
will make scanning go faster, but put an additional strain on the PC performing the scans. 

 
Logging Options: 

• Log File – The path to a file that will contain the results of the polling operation. 
• Logging Level – The level of detail that will appear in the log file.  The choices are: 

o Full – Records the progress of all PCs 
o Errors and Summary – Records only the errors (if any) and a summary 
o Summary Only – Records only the summary 
o None – No logging 

 
Note:  The file name displayed is automatically generated using an embedded date format for the 
current day. 
 
Status: 

• Data Collection Started – A progress bar showing the number of PCs where data 
collection has started 

• Data Collection Completed – A progress bar showing the number of PCs where the 
collection has completed 

• Status – A status window showing the current activity 
• Elapse Time – A running elapse time counter 
• Estimated Time Remaining – An estimate of the remaining time to complete the polling 

of all PCs. 
 
Note: During polling, the Close button becomes the Cancel button.  It may take several seconds 
to interrupt the polling process… be patient. 
 
4.4 View Menu 
 
The View Menu controls the visual aspects of the application. 
 

 
 
View: 

• Grid View - Displays all records in a grid similar to that of Microsoft Access.  Users can 
sort by a column by clicking on the column heading 

• Text View - A text-based view suitable for printing and saving to a text file.  Makes use 
of the Include Details in Text Report option to “filter” some of the less interesting data. 

• Report View – Uses a database-style navigator to view individual records. 







 
 
With appropriate authority, users can create queries, generate reports, etc., “as if” the entire 
database was a Microsoft Access *.mdb file. 
 



Frequently Asked Questions 
 
Part 1:  Running the applications 
 
Q: I get a message that says that I should install something 
 
A:  All of the SOSOS programs require the “.Net Framework” to be installed on the client PC.  
When using SOSOS to remotely gather information from PCs in a LAN, it is not a requirement 
that the remote PCs have the .Net Framework installed. 
 
Download and install the .Net Framework 2.0 from:  
http://www.microsoft.com/downloads/details.aspx?familyid=0856EACB-4362-4B0D-8EDD-
AAB15C5E04F5&displaylang=en 
 
Q:  I get some message about permissions… 
 
A:  One of the features of the .Net Framework allows users to set “code access permission” for 
the PC (or individual programs).  By default, the Framework's own security settings will not 
allow any program to run from a network share that requires "significant" permissions.  Since 
SOSOS requires a lot of permissions to work properly, the default settings will not allow it run 
from a network share.  Note: The default settings are sufficient when SOSOS is run from a local 
drive. 
 
To solve the problem, you can either copy the program files to a local drive, or adjust the .Net 
Framework assembly permissions. 
 
Warning: If you have multiple versions of the Framework installed, make sure you’re adjusting 
the setting for correct version.  Settings for one version have no affect on other versions. 
 
To adjust permissions, you use the .Net Framework 2.0 Configuration control panel applet (on a 
development PC).  Navigate to "Configure Code Access Security Policy", “Adjust Zone 
Security”, "Make changes to this computer".  Click on the Local Intranet icon and move the 
slider up to "Full Trust". 
 
You can also use the .Net Framework 2.0 Configuration control panel applet to create an MSI 
file that you can use to deploy these changes via a GPO or login batch to the other PCs in your 
LAN.   Click on the "Configure Code Access Security Policy", "Create Deployment Package".   
When the Wizard opens, click on the "Machine" security policy, and select a folder/name of the 
MSI file that will be created. 
 
Q: I adjusted the permissions, but it still doesn’t work 
 
A:  Make absolutely sure that you have adjusted the settings for the correct version of the 
Framework. 
 

http://www.microsoft.com/downloads/details.aspx?familyid=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en
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For version v1.0 and v1.1, Microsoft included the control panel applet with the Framework.  But 
for reasons that only they know, the control panel applet is not installed with version 2.0.  Only 
the development PCs get the control panel applet for v2.0. 
 
That means to adjust the settings on an ordinary PC without the applet, you must use the 
technique described above to create and deploy an MSI file. 
 
Q: I can’t run SOSOS against a remote computer running WinXP SP2; the connection 
fails. 
 
A: Most likely the problem is with the firewall settings.   The default setting for the built-in 
firewall for XP Service Pack 2 and beyond excludes remote administration.  Run the following 
on the remote PC to configure the firewall: 
 

 netsh firewall set service RemoteAdmin enable 
 
For additional information see:  http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/wmisdk/wmi/connecting_through_windows_firewall.asp 
  
Q: I can’t run SOSOS against a remote computer running Windows Vista; the connection 
fails. 
 
A:  By default, Windows Vista blocks WMI traffic, so you should adjust the Windows Firewall 
settings to allow for WMI traffic to pass.  Run the following on the remote PC to configure the 
firewall: 
 
 netsh advfirewall firewall set rule group="windows management instrumentation (wmi)" 
new enable=yes 
 
For additional information, see: http://msdn2.microsoft.com/en-us/library/aa822854.aspx 
 
Q:  I still can’t get SOSOS to run against a remote Vista PC; I get Permission Denied 
 
A:  If you are in a Workgroup environment (not a domain), you will have to disable the User 
Account Control (UAC) feature on the remote Windows Vista PC. 
 
From the Control Panel, click on User Accounts, and click on “Turn User Account Control on or 
off”.  Clear the checkbox and press the OK button.  (This change will require a reboot). 
 
Q:  I can’t run SOSOS against on a remote computer running WinXP Home  
 
A:  Microsoft has deliberately removed the ability to remotely administer computers running 
WinXP Home Edition (and Windows Me).  Note:  SOSOS runs locally on WinXP Home without 
any problems.  Sorry, there is no known work around. 
 
Q:  Why does it take so long to gather data on some PCs? 

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/wmisdk/wmi/connecting_through_windows_firewall.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/wmisdk/wmi/connecting_through_windows_firewall.asp
http://msdn2.microsoft.com/en-us/library/aa822854.aspx


http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/516.mspx?mfr=true
http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/516.mspx?mfr=true
http://support.microsoft.com/kb/892675/




http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/aptopnode.mspx?mfr=true
http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/aptopnode.mspx?mfr=true
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